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Installing and Running the
NMC-RX Application
This chapter provides procedures for installing the NMC-RX Element
Management System and its components on a Windows or Sun Solaris
system.
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System Requirements

To run the NMC-RX application, your system (Windows or Solaris) must
meet certain requirements.

Windows

To run the NMC-RX application, your Windows system must meet the
following minimum requirements:

• CD-ROM drive

• Windows 95/98, Windows 2000, NT 4.0 or later (preferred)

• 128 MB of RAM

• 330 MB of space on the hard drive (when installing)

• 266 MHz

Solaris

To run the NMC-RX application, your Solaris system must meet the
following minimum requirements:

• CD-ROM drive

• Solaris 2.7, Solaris 2.8

• 128 MB of RAM

• 300 MB of space on the hard drive (when installing)

• 266 MHz

Software patches are required for InstallAnywhere to run on Solaris 2.6,
Solaris 7, or Solaris 8. To find the required patch for your system, visit
these web sites:

• http://gamma.zerog.com/devnet_l/uT.jsp?page=kb/viewKB.jsp&itemID
=166)

• http://sunsolve.sun.com/pub-cgi/show.pl?target=patches/patch-access

Note: After you have installed Sybase Adaptive Server Anywhere, you can delete
the <NMC-RX installation directory>/sybase directory, provided you have not
installed Sybase in that directory. (Solaris installation only.)
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Installing the NMC-RX Application on Windows

There are four installation sets to choose from when installing the
NMC-RX application on a Windows system.

• All NMC-RX Components with Database Server – Installs the
NMC-RX Element Management System client software, database
schema, Polling service, ConfigSync service, and the Sybase Adaptive
Server Anywhere database.

If this is your first installation of the NMC-RX application, choose this
installation set.

• All NMC-RX Components – Installs the NMC-RX Element
Management System client software, database schema, Polling service,
ConfigSync service.

If you have previously installed the NMC-RX application and Sybase
database, choose this installation set.

• NMC-RX Client Only – Installs only the NMC-RX Element
Management System client software.

If Polling service, ConfigSync service, and the Sybase Adaptive Server
Anywhere database have been installed on another accessible
workstation on your network, choose this installation set.

Note: When you run the NMC-RX software, you must have Sybase Adaptive
Server Anywhere installed on your system or on another system that is accessible
on the network and already running.
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• NMC-RX Upgrade – Upgrades the currently installed components to
the version of the software being installed.

If you have a version of the software installed listed in Table 2-1 and
want to upgrade, choose this installation set. Releases before 4.1.x are
not upgradeable using this feature.

To revert to a previously installed version of the software, see
Reverting to a Previous Software Installation later in this chapter.

Refer to Table 2-2 for a description of each component.

Installing or Upgrading the Software

To install or upgrade the NMC-RX application:

1 Insert the NMC-RX CD-ROM in your CD-ROM drive. If the
installation program does not autoplay, double-click install.exe in the
Windows directory on the CD-ROM.

2 Follow the instructions that appear on the screen.

3 When the application is installed, reboot your system.

Table 2-1 Software upgrade compatibility

If You Have This Version Installed You May Upgrade To This Version

4.1.x 5.0.0

Table 2-2 NMC-RX application components

Application/Service Description

NMC-RX Element Management
System client software

Provides capability of managing devices on your
network via a graphical user interface (GUI)

Sybase Adaptive Server
Anywhere database

Provides database services and connections
needed to run the NMC-RX application

Polling service Provides the NMC-RX application with the status
of managed devices based on a defined polling
interval

ConfigSync service Enables the NMC-RX application to discover or
update a device on the network and builds a
model of the device in the NMC-RX database

Supports the application’s configuration save and
restore function

Resource Configurator Provides an efficient graphical interface for setting
up SNMP and the Sybase, Polling, and
ConfigSync service parameters
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Note: To obtain a license key, please contact your Juniper Networks sales
representative. If you would like to change your license key, see Modifying Your
License Key later in this chapter.

Note: A shortcut icon is placed on your desktop for each application and service

installed.

Before Running the Application

To run the NMC-RX application, Sybase Adaptive Server Anywhere must
be installed on a machine that can be reached by the NMC-RX
application.

Before you run the NMC-RX application, run the Resource Configurator
to verify that the settings for the database, SNMP, the Polling service, and
the ConfigSync service are correct. You do not need to run the Resource
Configurator each time you run the NMC-RX application.

You must start the database service before running the NMC-RX
application. Juniper Networks also recommends that you start the Polling
service and the ConfigSync service before running the NMC-RX
application.

See the following sections for information on how to run these
applications.

Resource Configurator

Before you run the NMC-RX application for the first time, you must run
the Resource Configurator to set up the NMC-RX parameters.

To run the Resource Configurator from your desktop, double-click the
NMC-RX Resources icon on your desktop.

To run the Resource Configurator from the NMC-RX application (after
the initial configuration):

1 From the Tools menu, choose NMC-RX Settings.

The NMC-RX Resource Configurator launches.

2 Configure the settings for each of the available services.

Note: If Polling service and/or ConfigSync service are running, you must restart
each service so that changes made in the Resource Configurator are reflected.
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Database Service

You must start the database before you can run the NMC-RX application.

To start the database service, double-click the appropriate Database icon
on your desktop. If you are running the database locally, the Database
icon appears in the Windows system tray. This indicates that the database
is available to the NMC-RX application.

If you are running the database on another machine, you do not receive
any indication that it is running. However, if the NMC-RX application
cannot connect to the database, an error message appears.

Note: Be sure to wait until the database is initialized before launching other
NMC-RX components. If an error occurs, close all NMC-RX components (including
the database) and start over.

Polling Service

You should run the Polling service before you run the NMC-RX
application, although it is not required. The Polling service generates a
log of events.

To start the Polling service, double-click the Polling service icon on your
desktop. The Polling service console window opens. This window
displays the ongoing activity of the polling service. If errors are
encountered during startup, an error dialog box appears.

Note: If you chose a client-only installation, no Polling service will be available on
your workstation. Polling service may be running on another machine which is
connected to the database.

ConfigSync Service

You must run the ConfigSync service before running the NMC-RX
application so that the devices you want to configure can be discovered.
Once the devices have been discovered, you can close the ConfigSync
service.

To start the ConfigSync service, double-click the ConfigSync service icon
on your desktop.

Note: If you chose a client-only installation, no ConfigSync service will be available
on your workstation. ConfigSync service may be running on another machine
which is connected to the database.
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Running the NMC-RX Client

When you run the NMC-RX client, you must have the ConfigSync service
running if you need to update or discover devices. Running the Polling
service is necessary only when you want to display the status of the nodes
you are working with.

To run the NMC-RX client:

1 Double-click the NMC-RX icon on your desktop.

The NMC-RX application splash screen and the NMC-RX User
Authentication dialog box appear.

2 Enter your username and password, and click OK.

The Network Workshop window appears.

Modifying Your License Key

To modify your license key:

1 From the NMC-RX client Help menu, click NMC-RX Licensing.

The NMC-RX Licensing Information dialog box appears.

2 To edit your license key, click Edit License.

The NMC-RX Licensing Information dialog box now shows an
editable text field, and the Edit License button changes to the Verify
License button.

3 Modify the license string, and click Verify License.

If the license string you entered is a valid license, the OK button is
enabled. If the license string is an invalid license, an error message
appears.

4 If the license string is valid, click OK to apply the license string to
the current session.

Note: The only valid license keys are those provided by Juniper Networks.
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Installing the NMC-RX Application on Solaris

There are three installation sets to choose from when installing the
NMC-RX application on a Solaris system.

• All Service Components – Installs the NMC-RX Element
Management System client software, database schema, Polling service,
and ConfigSync service.

• NMC-RX Client Only – Installs the NMC-RX Element Management
System client software

If Polling service, ConfigSync service, and the Sybase Adaptive Server
Anywhere database have been installed on another accessible
workstation on your network, choose this installation set.

• NMC-RX Upgrade – Upgrades the currently installed components to
the version of the software being installed.

If you have a version of the software installed listed in Table 2-3 and
want to upgrade, choose this installation set. Releases before 4.1.x are
not upgradeable using this feature.

To revert to a previously installed version of the software, see
Reverting to a Previous Software Installation later in this chapter.

Table 2-3 Software upgrade compatibility

If You Have This Version Installed You May Upgrade To This Version

4.1.x 5.0.0



Installing the NMC-RX Application on Solaris
NMC-RX Element Management System

2-9
Note: For the initial installation of this application, you must install the NMC-RX
application first, followed by Sybase Adaptive Server Anywhere (ASA).

Note: Sybase is not an option on the Solaris installation of the NMC-RX
application. You must install it separately.

Installing or Upgrading the Software

To install or upgrade the NMC-RX application:

1 Insert the NMC-RX CD-ROM in your CD-ROM drive and run
install.bin.

2 Follow the instructions that appear on the screen.

3 When the installation is finished, click Done.

A directory called sybase is created under the NMC-RX installation
directory.

Note: To obtain a license key, please contact your Juniper Networks sales
representative. If you would like to change your license key, see Modifying Your
License Key earlier in this chapter.

Installing Adaptive Server Anywhere

To install Sybase Adaptive Server Anywhere:

1 Navigate to the Sybase directory by typing cd <NMC-RX
installation directory>/sybase.

2 Press Return.

3 Type ./setup and press Enter.

4 Follow the directions on the screen.

Before Running the Application

To run the NMC-RX application, Sybase Adaptive Server Anywhere must
be installed on a machine that can be reached by the NMC-RX
application.

Before you run the NMC-RX application, run the Resource Configurator
to verify that the settings for the database, SNMP, the Polling service, and
the ConfigSync service are correct. You do not need to run the Resource
Configurator each time you run the NMC-RX application.

You must start the database service before running the NMC-RX
application. Juniper Networks also recommends that you start the Polling
service and the ConfigSync service before running the NMC-RX
application. Scripts that launch NMC-RX components are also available.
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See the following sections for information on how to run these
applications.

Resource Configurator

Before you run the NMC-RX application for the first time, you must run
the Resource Configurator to set up the NMC-RX parameters.

To run the Resource Configurator from the shell:

1 Type cd <NMC-RX installation directory>/bin

2 Run ./NMC-RXResources to configure the database, SNMP, Polling
service, and ConfigSync service.

Note: If ConfigSync service will be running on this workstation, ifconfig -a
provides the Solaris IP address for FTP on the ConfigSync service tab.

To run the Resource Configurator from the NMC-RX application (after
the initial configuration):

1 From the Tools menu, click NMC-RX Settings.

2 Configure the settings for each of the available services.

Database Service

The NMC-RX application requires that a Sybase database connection be
established before running the NMC-RX software. You can run nmcrxdb
from the utils directory or from the command line:

• For the NMC-RX Database connection, use:

dbsrv7 -ti 0 NMC-RX.db

• For the DemoDB database connection, use:

dbsrv7 -ti 0 NMC-RXDemo.db

Polling Service

You can configure the Polling service from <NMC-RX installation
directory>/bin/ by running ./NMC-RXResources.

• Registry Port – Default is port 1099.

You can start the Polling service from <NMC-RX installation
directory>/bin/ by running ./PollingService, or by using the polling script
located in the utils directory.
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Note: Some problems will not stop the Polling service from running or remaining
active. Therefore, if there are issues, it is always advisable to check <NMC-RX
installation directory>/log/PollingServer.log for recent messages.

ConfigSync Service

Verify that the FTP Home Directory has been granted write permission.

You can configure the ConfigSync service from <NMC-RX installation
directory>/bin/ by running ./NMC-RXResources.

The most important configuration issues to remember are:

• FTP destination IP address – Enter the IP address of the machine
running the ConfigSync service.

• FTP login name

• FTP password

• FTP destination sub directory – Be sure the subdirectory is created
under the ftproot directory. It is case sensitive.

• Local root directory – Case sensitive

• If FTP is configured properly, the following URL should bring up an
FTP connection to the ifStack directory when placed in a Web browser
address line:

ftp://your ip address here:21/ConfigSync/ifStack

To test further, add a file to the ifStack directory to verify that it can be
seen and accessed.

• Registry port – Default is port 1098.

You can start ConfigSync service from <NMC-RX installation
directory>/bin/ by running ./ConfigSyncService.

Running the NMC-RX Client

You can start the NMC-RX application from <NMC-RX installation
directory>/bin/ by running ./NMC-RX.

Note: The recommended way to run the application is to use the scripts that are
provided with the NMC-RX application. See the next section.

If you do not use the scripts to run the NMC-RX application, you need to
do the following:

• Set up the LD_LIBRARY_PATH to contain the Sybase ASA library
directory. The default directory is /opt/sybase/SYBSsa7/lib.
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• Set up the search path to contain the Sybase ASA bin directory. The
default directory is /opt/sybase/SYBSsa7/bin.

Using Scripts

Scripts provided for all NMC-RX application components can be found in
the <NMC-RX installation directory>/utils directory. The allnmcrx script
launches the NMC-RX database and all NMC-RX components.

If you want to launch an individual component, select the appropriate
script from Table 2-4.

Note: All script names are one word, lowercase, and are in the <NMC-RX
home>/utils directory.

The following line in the nmcrxdb and nmcrxdemodb script must be
changed if Sybase is not located in the default path locations supplied:

• SYBASE=/opt/sybase

Script Parameters

The scripts accept the following parameters:

Start This is the default behavior of each script. If the script is called
without any parameters, it starts the appropriate application. If the
application being started is already running, it reports this to you and does
not try to start the application again.

Table 2-4 Scripts for Solaris

Script Function

allnmcrx Affects the database, Polling service, ConfigSync service, and the
NMC-RX application

Note: This is the recommended way to start all NMC-RX services
on Solaris.

allservices Affects the database, Polling service and ConfigSync service

configsync Affects the ConfigSync service

nmcrx Affects the NMC-RX application (only has start and console
options)

nmcrxdb Affects the NMC-RX database

nmcrxdemodb Affects the NMC-RX Demo database

polling Affects the Polling service
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In the scripts that affect multiple applications, pauses are added in order to
be sure that the database has been started before trying to start the next
application in line. Each application is checked for status, and if the
application is already running, that application is not started again.

Stop The status of the application is checked, and, if the application is
running, it is shut down. If the application is not running, you are notified
that it is not running.

In the scripts that pertain to multiple applications, each application’s
status is checked. Those applications that are running are shut down, and
those that are not running display a message that they were not running.
You are then notified whether the application was successfully stopped or
not. NMC-RX clients will not be shut down.

Restart The status of the application to be restarted is checked. If the
application is running, it is stopped, and then started again. If it is not
running, it is started at this point.

In the scripts that pertain to multiple applications, all applications are
stopped. NMC-RX clients are not restarted. Any clients currently running
are notified that the database connection has been lost, and that they need
to restart the client.

Note: The NMC-RX script does not support this option.

Console When this parameter is present on the command line, a new
dtterm terminal window is started with the name of the application. The
application’s console output is displayed in this window.

Status Reports whether or not an application is running. In the case of
the multi-application scripts, this parameter displays the status for each
application checked.

Note: The NMC-RX script does not support this option.

Help or ? Displays the script’s command line parameters.
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Reverting to a Previous Software Installation

If you chose the NMC-RX Upgrade option during installation, you have
the capability of reverting to a backed-up version of the NMC-RX
software later. During installation, backup application files are saved to an
install-specific folder in the rpbk directory, located in the installation
directory. A revert script is also included in this directory.

If you need to revert to a previous version, run the script nmc-rx-revert in
the folder of the version you want to revert to. For full installation
upgrades, all data entered into the application between the dates of the
upgrade and the date you are performing the revert will be lost (a warning
is displayed beforehand). For client-only upgrades, no warning appears
because no database information is stored on a client-only system.

Exiting the NMC-RX Application

When you have finished configuring your ERX device and have saved the
changes you want, you can exit the application.

To exit the NMC-RX application:

1 From the Network Workshop, choose Exit from the File menu.

2 Click Yes in the confirmation dialog box.
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